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1. The Dashboard
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Compressor Assembly
Deployment
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Attendance Data Last Import: 09/06/2012 at 10:50 AM EDT

Status: Success.

Find an employee by name

* Absent This Month

‘ August 2012
s M T W

12 13 14
19 20 21

26 27 28

¥ Recently Viewed

Jensen, Brian K
Krampe, Neil F
Balcome, Robert
Culey, Brian R
Harvey, Lance K

* Employees at Risk

Arnsby, David A
Davis, Leroy
Hirkaway, Robert P
Jackiewicz, Jeffrey L
Kent, Duane D
Lake, Jimmy D

¥ FMLA Watch

Fox, Robert E
Harvey, Cassandra L
Harvey, Lance K

¥ On Leave Now

» FMLA

w Layoff
Ingraham, Kenneth
Bellamy, Desiree X

v Long-Term Disability
Bellamy, Desiree X

* Probation Watch

Bergeron, Keith
Bonga, Laura
Hansen, Phillip
Heether, Jason
Packer, Elijah

* Perfect Attendance

» 180 Days
» One Year
v Five Years
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Patin, David A
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19.0 Points
19.5 Points
23.0 Points
20.0 Points
15.0 Points
20.0 Points

6 weeks left
7 weeks left
5 weeks left

for 34 weeks
for 40 weeks

for 40 weeks

2 weeks left
1 month left

1 week left
3 days left
1 week left

2899 days
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Each user can build his or her own Dashboard page from among sixteen customizable panels. Essential

data bubbles up to the dashboard so that you can spot trends and monitor irregularities before they become

problems.
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2. Department View
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Acme Tools > Compressor Assembly

Employee List

Employee Name Shift
Culey, Brian R First
Dakin, David 5 (T) First
Davis, Leroy First
Feehan, Scott P First
Geister, Daniel L Third
Gross, Dennis C First
Harvey, Lance K First
Jensen, Brian K First
Mcginn, Kevin 1 (T)

Meilleur, Keith P First
Osier, Eugene W Second
Wymer, Maria L Second

Absenteeism: Department vs. Prior Year
6% Prior Year [ Current Year
4%
2%
~amninnlenini

Ot Nov Dec Jan Feb Mar Apr May Jun  Jul Aug Sep

Absenteeism: Department vs. Company

Acme Tools [l Compressor Assembly

Oct Mov Dec Jan Feb Mar Apr May Jun  Jul Aug Sep

Attendance Data Last Import: 09/05/2012 at 07:45 PM EDT
Status: Error.

" Absent This Month

4 August 2012
s M T w T

1 2
8 9
15 18
22 23

29 30

" Absent This Week
Yesterday, Feb 14th
Wednesday, Feb 13th
Tuesday, Feb 12nd
Monday, Feb 11st
Sunday, Feb 10th
Saturday, Feb 9th
Friday, Feb 8th

" On Leave Now

FMLA
Layoff
LOA
Long-Term Disability
Military Leave
» Vacation

Like the Dashboard page, the Department View is comprised of panels, providing department-specific
information for a supervisor or admin user. The charts and tables that you see here (and throughout the
solution) are “live” and interactive — click on a date in the calendar, for example, and you’ll get a list of all of
the time card exceptions (in that department) that happened on that day.
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3. Employee Profile
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| Acme Tools > Compressor A bly > Brian K J 4 p
Employee Summary
Employee Name: Jensen, Brian K N _ ~ —

Employee Number (Badge): 0000010441 (3044674) e
Department: Compressor Assembly 2012 | 201
Shift: First 8
n e Total Points
Hire Date: 11/18/97 0
Status: Active MAMJJASONDJF Hmnn 13.0%
Display Options Absenteeism Rates ':i:' Daily Schedule '@' FMLA Center ':i:‘

8 MEmpl Mpept W Comp

Show unexcused occs .. . ' M Taken
Show excused occs 4 | Remaining
Show benefits 0 . . - Su Mo Tu We Th Fr Sa

3Ma EMo  12Ma 9 10 11 12 13 14 13
Attendance History ®
Date Type Hours Points
12/03/11 Sat Early Out 0:07 0.5
12/04/11  Sun Medical Appointment 8:00 1.0
12/05/11  Mon Mo Call / No Show 8:00 1.0
12/08/11  Thu Wacation B8:00 0.0
12/09/11 Fri Vacation 8:00 0.0
12/19/11 Mon Layoff (Short-Term) 8:00 0.0
12/20/11  Tue FMLA 8:00 0.0
01/12/12 Thu Tardy 0:07 0.5
01/29/12 Sun Family Iliness &:00 0.0
02/28/12  Tue FMLA 8:00 0.0
03/04/12  Sun Sick 8:00 1.0
03/11/12  Sun Jury Duty 8:00 0.0
03/12/12 Mon Medical Appointment &:00 1.0 &
03/19/12  Mon Weather 0:45 0.0
04/19/12  Thu Personal Day 7:00 0.0
05/01/12 Tue Left Early 6:00 1.0
05/02/12  Wed D Violation: Verbal Warning: 10 Pts/yr
05/03/12 Thu Sick 8:00 1.0 & -

The Employee Profile page provides a comprehensive look at the employee in question.

From here you can view and edit attendance data (going all the way back to hire date); check FMLA usage
and eligibility; generate DOL forms or company-defined PDF forms (automatically filled with employee data);
create FMLA and Disability workflow items; initiate progressive disciplinary action for non-attendance
infractions (such as safety, conduct or performance violations); check schedules, attach documents; print
and email reports and letters, and much more.
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4. Alerts Page
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Alert List

Status: Error.

Y Reports Y
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Attendance Data Last Import: 09/05/2012 at 07:45 PM EDT

Previewed (1)

Closed (202)

Home Alerts
Display Options (advanced) n Include Items with Status
Include alerts thru: |Tc|da*,I |v| New (4) Emailed (0)
Printed (4) Ongoing (1)
Show departments: |{AII] |v |

Date Employee Name DeptNum Alert Type Status
08/30/12 Jensen, Brian K GVDPLR B Written Warning (12 Pts) Mew -
08/29/12 Mills, Todd E GVYAUTZ Written Warning (12 Pts) Mew
{[¥]:07/23/12 Hoose, David E GvTLRM  [E] Verbal wWarning (10 Pts) Printed
.07f17.-’12 Fox, Robert E GVYTAND g Reached Max FMLA (480 Hrs) Printed
06/15/12 Marshall, Brian M GYAUTZ m verbal Warning (10 Pts) MNew
06/14/12 Roesler, Richard E GVPROD B Final Warning {14 Pts) Printed &
04/26/12 Culey, Brian R GVYDPLR G Outstanding Attendance Mew
04/25/12  Krampe, Neil F GYPRS1 m Conduct Issue: Insubordination Previewed
01/24/12 Balcome, Robert HPWQR m Safety Violation: Horseplay on floor Printed &
12/28/11 Harvey, Lance K GvDPLR [ FMLA Case: Birth of a child Ongoing &%

10 items displayed

The Alerts page is a “to do” list of employees that require your attention. When an employee hits enough
points to trigger a disciplinary step, that employee is automatically added to this list, and a corresponding
violation notice is created. The notice can be printed or emailed by selecting the record from the list and then
clicking Print or Email.

When you get the signed notice back from the employee, you can use the Sign Off button to close the item,
and it will drop off your “to do” list. That ensures that this list is always short and current.
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5. Reports Page
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Report Contents Scope of Report
@ EEs with at least [ | [point(s) [~] Department(s): (A0 [v] L""""‘"""“J
o eeswmn [ o wre: (o -
() EEs with Perfect Attendance
- - - Sort Options
(7 Specific Employee: |,|';|'ahan' Kenneth |v|
() Reports of Absenteeism by Department Sort By: m
() Report of Policy Violations Group by Department

|:| Page Break on Department

Report Type ® What Time Period

() Summary Report @ Predefined: |Twelve months thru today |v ‘

@ Full Detail Report © custom: [1/1/2013 | @ to[2/15/2013 | &)
Include statistics box

Include unexcused occurrences Other Options

Include excused occurrences

Indlude benefit [] Include Terminated Employees
nclude benefits

Page Break on Employee

Suppress Closed Violations

) Incident Analysis Report

The reporting module in Attendance Counts was designed around one simple principal: impressive reports
aren’t especially impressive if you don’t ever end up using them.

Behind this deceptively simple Ul is a powerful reporting and query engine that invites you to generate a
wide variety of reports, all configurable on the fly. You’ll get summary and detail attendance reports;
absenteeism reports with department and company averages; analysis reports that break down absenteeism
by occurrence type and day of week; FMLA usage reports; retention reports; violation reports and perfect
attendance reports. To those, you can add additional reports based on native or calculated fields that you
choose. The result is a customized suite of reports that fits your business.

What makes our reports so effective is that you'll actually use them.
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6. Admin Page
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Users and Passwords ® Policy Rules
User Name Read Update Last Logged On Alert Name Type
& Jasen 5. Full Mone 8 months ago 2 [3 Reminder System -
& Charles P. Full Full 6 months ago [7] Outstanding Attendance Award
& Tammie R. Full Partial Never m verbal Warning (10 Pts) Violation
‘.‘ Admin Full Full 6 months ago Written Warning (12 Pts) Violation
& bb Partial  Partial 2 months ago B Final Warning (14 Pts) Violation
& occ Mone Mone 2 months ago n Termination (16 Pts) Violation
... Demo User Full Full 5 months ago m Safety Violation Mote
& joel Full Full Active = m Performance Issue Mote i
Users Currently Logged On Form Letters @
User Name Active Since Form Letter Name Modified 3
& Joel (you) 1 hour age Discharge Notice 12/9/2012 it
Final Warning Notice 12/9/2012
Archived Employees FMLA Natice (11 weeks) 8/1/2012
Employee Name Terminated FMLA Motice (12 weeks) 8/1/2012
Bronson, James R 11/23/2011 E:j Insuburdll.'latlon Notice 8/1/2012
Petersen, Gary D 11/23/2011 = Other Notice 8/1/2012
.
Huey, Deber O 11/23/2011 Other NOt!ce #1 8/1/2012
Porter, Robert E 11/23/2011 Other Motice #2 8/1/2012 -
Mcginn, Kevin ] 11/23/2011
Hancock, Michael L 11/23/2011 Home Tab Panels (enable/disable, control access)
Dorey, Christopher 11/16/2011 » Company View i
Casey, Kenneth R. 11/9/2011 - } Department View
» Employee View -
Company Holidays ®
» 2011 -
r 2012
b 2013 -

The Admin Page gives you control over assorted administrative tasks, such as adding new users,
customizing your policy rules, personalizing the colors and icons used throughout the application, editing
your form letter templates, and controlling what dashboard panels should be available to different types of
users.
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7. Nightly Email Summary
( Hd9 0«9 @ |= Attendance Counts: Daily Summary (6 new alerts) - Message (HTML) = B R
Message @ 9

© If there are problems with how this message is displayed, click here to view it in a web browser.

From: acweb @attendancecounts.com

To: joel@metsoft.com

Cc

Subject: Attendance Counts: Daily Summary (6 new alerts)

Sent: Wed 1/16/2013 5:17 AM

Attendance Counts: Alerts Summary
(as of 5:16 AM, Wednesday, January 16, 2013)

You have 6 new alerts (and 3 other open alerts):

1/13/2013 Q Bush, Bridget Written Wamning (4 Pts)
1/12/2013 g Moyer, Michael Written Warmning (4 Pts)
1/12/2013 @ Ragland, Tranard Termination (8 Pts)
1/12/2013 u Campos, Hector G Termination (8 Pts)
1/11/2013 0 Campos, Hector G 2nd Written Waming (7 Pts)
1/1/2013 U McCray, Tyrone Quarterly Perfect Attendance

11/1/2012 g Troy, Morgan M 2nd Written Waming (7 Pts) Status: Printed
11/1/2012 g Wilson, Jonathan Keith Written Waming (4 Pts) Status: Printed
10/24/2012 g Troy, Morgan M Written Waming (4 Pts) Status: Printed

To view alerts page click here : View Alerts
To stop receiving daily summary emails, click here : User Settings

This message was generated by AttendanceCounts Web™ Metropolitan Software, Inc.

&

:

@ acweb@attendancecounts.com

Ky -

If you sign up for email summaries, you'll get a nightly email message which lists all open alerts — a “to do”
list of sorts. The email ensures that you're notified right away when an employee requires attention.

Note too that the email message is interactive. If you click on an employee’s name, it will automatically log
you into the ACWeb website and take you to that employee’s profile page.

Items will continue to appear on the nightly email summary until they are ‘closed’ from within ACWeb.
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